PROGRAMMING THE CYBER MILL

The tabulation used in the CNC program editor follows example from the literature, with the column headings as Address Characters defined in the BS 3635 Specification. Minor variations include the use of T for tool size and the use of D for dwell time.

The convention used in circular interpolation assumes that the last programmed move brought the cutting tool to the start point for the arc. The finish point for the arc defined in the interpolation move is then relative to the start point in incremental terms for X and Y with the centre of the arc also in incremental terms I and J. The datum point for X,Y, Z, is not used and as a consequence, I and J are always positive.

Before writing a program, the examples on the distribution disc should be examined and perhaps run to give a degree of confidence and understanding of the ISO programming conventions.

Edit Screen

The edit screen for the Cyber Mill is presented on top of the stack of device and cell definition windows, when the mill is first declared as part of the cell from the cell menu or whenever selected thereafter, from the windows menu devices option.

The meaning of the column heading Address Characters are as follows:

- N Line number
- G Preparatory function, generally relating to the cutter
- X,Y,Z Co-ordinates of the next position to move to
- I,J Incremental co-ordinates of the centre of a circular arc
- F Feed rate for the move
- S Spindle speed
- T Tool diameter
- D Dwell time in seconds
- M Miscellaneous functions

All dimensions may be specified in millimetres or inches using the G70 and G71 codes, respectively.

Entries may be made into any of the column positions and edited by over-typing as appropriate using the keyboard cursor and tab keys to move between fields and the Ctrl+I, Ctrl+D combinations to insert and delete lines or rows, respectively. Auto-line numbering is imposed and greyed-out in the Edit menu, giving line numbers in single increments.

Previously written programs in the G&Mode format may be loaded into the edit window from the Load selection in the File menu. Programs in other formats may also be loaded using the Import selection from the File menu. The import file types include HPGL, NC Drill, Gerber and ASCII, making the distinction in the latter case between programs in G&Mode written in the edit window and those written with a conventional text editor, when the address character must be stated for every entry.

If the NC Drill file shown here, gauge.h10 is selected for loading, the dialogue for the NC Drill Post-processor will be displayed, listing the drill sizes to be used for the various depth of cut and feed rates. The dimensions of the blank may be set as well as the load point and five check boxes for alternatives.

When the setting have been accepted by using the OK button, the post-processing occurs with a horizontal bar display to indicate progress, and the save file dialogue box.

Once the file is saved as required, the processed file in the Mill edit window is revealed ready for program execution, either in the material or in simulation to check beforehand.
ISO Format Programming the Mill

Many good books have been written on CNC programming and this section of the manual should be read in conjunction with one of them, particularly one that is based on the use of the ISO G and M Codes.

From the large range of standard preparatory and miscellaneous function codes (G and M Codes), the ones that are accepted within Walli3 form a sub-set that demonstrate the basics of CNC machining, on a machine capable of doing useful work, either stand alone or as part of an integrated multi-task/CNC workcell.

The cutting program is written on the host computer in ISO format, using an edit window for each of the CNC devices declared in the Cell Definitions Window. The CNC editor accepts the most widely used G and M codes that are relevant to the machine operation, in a conventional tabular statement. This is then compiled after saving, as a CNC program suitable for transmission to the control processor in the device, to be run under supervisory control from the Workcell program. Two non-standard but permissible G codes, are also accepted.

ISO Preparatory and Miscellaneous Codes Supported for the Mill

Standard G Codes

G00 Rapid Positioning Point-to-Point

This is used when moving the cutter between the end of one cut and the start of the next. It should never be used when the cutter is in contact with the work-piece.

G01 Linear Interpolation

This takes the cutter along a straight line from the last defined position to the position defined by this coded line. Interpolation is confined to the X-Y plane, and if Z is defined the move will precede the interpolation.

G02 Circular Interpolation Arc, Clockwise

This takes the cutter in a circular arc of up to 90° in a clockwise direction from the last defined position to the position defined by this coded line. The centre of the arc is defined by the I and J incremental parameters for the X and Y co-ordinates, respectively.

G03 Circular Interpolation Arc, Counter-Clockwise

This takes the cutter in a circular arc of up to 90° in a counter-clockwise direction from the last defined position to the position defined by this coded line. The centre of the arc is defined by the I and J incremental parameters for the X and Y co-ordinates, respectively.

G04 Dwell

This defines a wait period, the value of which is set in the D or Dwell field in seconds.

G05 End Subroutine

Used to mark the end of a section of code intended to be obeyed as a subroutine and declared by the corresponding Subroutine Start code, G28.

When the G05 code is obeyed, the program sequence is returned to the line following the call to the subroutine.

G06 End Loop

Marks the end of a Loop Cycle sequence.

G28 Subroutine Start

The code which is entered as the first line of a block intended as a subroutine to the main G and M code program. The code is accompanied by a statement in the X field, which is the subroutines numerical label or name.

G36 Face Milling Cycle

This is a non-standardised fixed cycle for skimming the face of a blank. X and Y define the area to be skinned and the cut proceeds in the positive directions from the start point. Since the tool has a defined diameter, the start point for the cycle, as defined by the previous move, must accommodate the half diameter with an inscribed position at the top left-hand corner of the area defined.

G65 Call Subroutine

The code used to call a subroutine from the main part of a G and M code program.

The code is accompanied by a statement in the X field, which is the numerical label or name of the subroutine, as declared with the Subroutine Start code.
G70  Imperial
Sets the imperial inch as the unit for all subsequent dimension entries.

G71  Metric
Sets the milli-metre as the unit for all subsequent dimension entries.

G73  Loop Cycle
Marks the beginning of a sequence of commands that will be repeated the number of times entered as an integer in the X column. Obeyed in the incremental mode, typically allows a cutting sequence to be repeated at equal intervals along the X and Y axes.

G81  Drilling Cycle
This is the standardised fixed cycle for drilling holes.

G82  Drilling Cycle with Dwell
This adds a wait period to improve the finish at the bottom of the cut.

G83  Peck Cycle with Dwell
An intermittent feed cycle with a wait period to improve the finish at the bottom of the cut. To avoid the drill flute becoming clogged, the drilling is interrupted after the penetration defined in the I parameter field, defaulting to 3mm, and lifted clear of the hole. The start position for the drilling operation is determined by the previous moves.

G90  Absolute programming
After specifying absolute programming each subsequent X,Y and Z dimension entered is interpreted as the co-ordinate from the zero datum. The default position for the zero datum is the Home position established by the control systems use of the limit switches on each axis, which is with the cutter fully retracted from the work piece and with the table fully forward and fully to the right. The cutter is then over, and its cutting axis passes through, the rear left corner of the vice. The zero datum may be altered by applying offsets, using the manual controls or their equivalents in the CNC Mill Jog dialogue box, accessed from the Options menu, or by program using the G92 code.

G91  Incremental programming
After specifying incremental programming, each subsequent X,Y and Z dimension entered is interpreted as the distance from the last defined position to the one currently defined in the coded line. As a consequence, the dimensions may be either positive or negative.

Note: Both G90 and G91 are single entries on a line.

G92  Shift Zero Datum
This allows a program statement in the X,Y and Z fields of an offset from the machine datum, or home position, to some other zero datum which will thereafter be the zero reference for the X,Y,Z program co-ordinates.

Note: The home position is returned to automatically, at the start of the program execution.

Non-Standard G Codes

G38  Pause for Input
This allows the Mill to act autonomously on logic inputs, rather than through the Workcell control. The X and Y fields are used for logic inputs going low and going high, respectively, the entry being the numbered input in the range 1 to 8.

G39  Set output
This allows the Mill to autonomously drive logic outputs. The X and Y fields are again used, as for inputs.

G98  Configure Engrave ( used with Engrave Text, G99 )
The two codes are used as a pair, usually in numerical order although this need not be the case, and they may be split, such as in a loop cycle to engrave at different places.

The text is centred at the current position and may be orientated in the four 90° positions by specifying a number 1 to 4 in the X field of the G98 code statement, and each orientation may be mirrored for reverse engraving using the numbers 5 to 8.

One of 19 fonts may be selected by number in the Y field. The fonts are comparable to those from the normal choice in AutoSketch.

The maximum number of characters is specified in the Z field, with zero indicating an unlimited number.

Default text may be specified in the Remarks field, to appear in the dialogue box which is presented at run time, if text for engraving is not stated in the Remarks field of the G99 code. If the default is also left blank, a blank dialogue box will be presented.

G99  Engrave Text ( used with Configure Engrave, G98 )
The dimensions of the text are given in the X and Y fields of the G99 code statement but, if X
is not specified, the spacing and character width will be as defined in the font.

The Z field specifies the depth of cut, usually set to 1 mm, say, if a 2 mm ball ended engraving tool is used.

The text to be engraved is stated in the Remarks field, but if this is left blank, a dialogue box for the text is presented at run time, which contains the default text, if this has been specified by the G98 code, or it will be blank ready for a run time entry.

Miscellaneous Functions

*Note*: Because of the modal character of many of the preparatory functions, that is they stay in operation until changed or cancelled, it is advisable to have a G code on all lines that have an M code, even if this is a dwell, G04 with zero dwell time, to cancel the previous G code. M codes are executed before G codes.

M00 Program Stop

This stops the program waiting for the motor current to be switched off and then on again. It is useful for tool changes and when setting the Z axis offset. While in the stopped state, the Monitor LED will flash rapidly and the continue may be selected from Control Panel dialogue.

M02 End of Program

End of program is an implied function which is obeyed automatically at the end of program execution. However, the M02 code may be used in program, either to truncate further execution, or to force a stop during program development, say.

M03 Spindle Clock-Wise (CW)

This switches on the cutter motor in the clockwise direction, the normal direction for cutting. The speed of the motor should be specified in the same line, otherwise a speed previously specified, set manually or through the Jog CNC Mill dialogue box replica of the manual control panel, will be used.

Suitable speeds are in the range zero to 4500 rpm selected by number in the range 0-9.

M04 Spindle Counter Clock-Wise (CCW)

This reverses the spindle motor direction from that normally used for cutting.

M05 Spindle Off

This stops the cutter motor.

M08 Turns the air blast on to remove swarf.

M09 Turns the air blast off.

M68 Clamp Work-Piece

This switches on the small electric motors to close the index positioning device and jaw of the vice, in sequence, to clamp the work-piece.

M69 Unclamp Work-Piece

This reverses the closing sequence, to return the jaws and index positioning device to the fully open position.

Graphical Presentation - Mill

A graphical execution, without cutting a work-piece, may be selected by placing the Mill or Lathe off-line from the Run menu. This presents a new window as an overlay, in which the work-piece is shown to the size set from the Size dialogue box, and the cut is drawn in the programmed position in relation to the top left hand corner, irrespective of the actual size work-piece. Note that the right hand information window stacks are not used for the graphical execution, they being reserved for graphics more appropriate to the programming and setup phase, as for the robots and workcell.

The simple illustration used here is from the first example program for the Mill, DEMO_CM1.

Different colours are used to show depth of cut, which is summarised in a superimposed display box when the Key option is selected from the menu bar of the graphics window. The colours and numbers will change as the execution progresses. Since the programs written with the editor produce G&Moode format files, the colours are allocated in order from the list ascribed to the HP pen Carousel for HPGL files. When the program is produced from AutoCAD and imported in HPGL format, the colours will be as allocated for the different depths of cut in the AutoCAD work.

Use of the Pen Adapter

The Draw selection from the Run menu has the effect of inhibiting all cutter motor operations and limiting the movement of the Z axis to a narrow range, with the pen just above the paper, just touching the paper ready to draw. These modifications to the cutter operation ensure
that the pen is not damaged, but at the same time the Z parameter is interpreted as the depth of cut which is to be shown by the drawing. A drawing block with the paper fixed to it, is used in place of the work-piece.

Before cutting a complex shape, the path of the cutter may also be confirmed to be correct using the graphical simulation using Draw off-line, but more precisely by drawing with a pen in the chuck of the spindle motor. Using the pen in the development stage of a program also saves spoiling expensive material.

The pen supplied with the mill is a disposable plotter pen (Staedler Marsplot 32H-P03K-9, as used for Hewlett Packard plotters 7221, 7225, 7470, 7475, 7550 and 9872, and also available from Farell Electronic Components under their part number 176-187).

Setting-up the Mill

Push the pen fully into the adapter, fit the adapter fully into the spindle motor chuck and then remove the cover for the pen.

Lay a sheet of A4 paper, trimmed to size over the drawing holder block, wrap the edges underneath and secure the paper with the two plastic binding clips provided.

Open the vice, using the control from the dialogue box and place the drawing holder on the Mill table. Finally close the vice to clamp the drawing holder into the correct position.

Running the Program for Drawing

After Homing, the pen will be brought down to a position just above the paper. Using the manual control buttons for the Z axis, move the pen fractionally down to be just in contact with the paper. Switch the Motor Power off and then on again. The program will now run with the pen at the two alternative heights, just above the paper and in contact whilst drawing. Whereas in the Graphics Simulation the different depths of cut are drawn in different colours, the one pen is used for all depths of cuts in the drawing. For complex machining, the interpretation of the drawing may well be aided by the graphics.

When the program is completed, the pen will be raised well clear of the paper so that the drawing holder may be removed from the vice.

Note: Replace the cap onto the pen as soon as the drawing is complete, to prevent it from drying out.

Engraving Text

The use of these non-standard codes is best given by example, such as tabulated below and which is taken from the program, g_keyfob.ncm, and specifies the text "Fred", of maximum height 9.00 mm engraved to a depth of 1mm. The width of text is not specified in the X field, so the text will be engraved with a spacing and character width un-scaled from the font description.